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Documentation Notice

The information and software described in this document are furnished only under a separate agreement and
may only be used or copied according to the terms of such agreement. It is against the law to copy the
software except as specifically allowed in such agreement. Complying with all applicable copyright laws is
the responsibility of the user. Without limiting the rights under copyright law, no part of this document may be
reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any means
(electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express
written permission of Hyland Software, Inc. and/or one of its affiliates.

Hyland, OnBase, Alfresco, Nuxeo, Content Innovation Cloud, and other product or brand names are
registered and/or unregistered trademarks of Hyland Software, Inc. and its affiliates in the United States and
other countries. All other trademarks, service marks, trade names and products of other companies are the
property of their respective owners.

© 2026 Hyland.

The information in this document may contain technology as defined by the Export Administration
Regulations (EAR) and could be subject to the Export Control Laws of the U.S. Government including for the
EAR and trade and economic sanctions maintained by the Office of Foreign Assets Control as well as the
export controls laws of your entity’s local jurisdiction. Transfer of such technology by any means to a foreign
person, whether in the United States or abroad, could require export licensing or other approval from the U.S.
Government and the export authority of your entity’s jurisdiction. You are responsible for ensuring that you
have any required approvals prior to export.

DISCLAIMER: This documentation contains available instructions for a specific Hyland product or module.
This documentation is not specific to a particular customer or industry. All data, names, and formats used in
this document’s examples are fictitious unless noted otherwise. This document may reference websites
operated by third parties. In such a case, Hyland has no control or liability for the content of such third-party
websites. The inclusion of such a link shall not constitute an endorsement or affiliation with such a third-party
website; the reference is provided for information purposes only. If you have questions about discrepancies in
this document, please contact Hyland. Hyland customers are responsible for making their own independent
assessment of the information in this documentation. This documentation: (a) is for informational purposes
only, (b) is subject to change without notice, (c) is confidential information of Hyland Software, Inc. and its
affiliates, and (d) does not create any commitments or assurances by Hyland. This documentation is provided
“as is” without representation or warranty of any kind. Hyland expressly disclaims all implied, express, or
statutory warranties. Hyland's responsibilities and liabilities to its customers are controlled by the applicable
Hyland agreement. This documentation does not modify any agreement between Hyland and its customers.
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Manage workflow

Create a workflow process

A workflow process contains a series of tasks and rules reflecting the review path a workflow item must take
in order to meet the sign off and approval requirements of your work group. To create a workflow process,
complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Workflow.

3. Intheright pane, on the Workflow tab, click New.

4. Inthe Add Process dialog box, type a name and an optional description.
The description appears in the ToolTip for the process.

5. Click OK.

Next Create queues, routes, and rules to define the components in your new workflow process in Workflow
Designer.

Modify a workflow process

To modify a workflow process, complete the following steps.
Prerequisite All other users must close the process.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Inthe left pane, click Workflow.
3. Intheright pane, on the Workflow tab, select a process and then click Modify.
4. When you are finished modifying your workflow process, close Workflow Designer.

Rename a workflow process

To change the name of a workflow process, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the

list.
2. Intheleft pane, click Workflow.
3. Inthe right pane, on the Workflow tab, select a process and then click Rename.
4. Enteranew name for your process.



Delete a workflow process

To delete a workflow process and remove all workflow items in its associated queues from workflow,
complete the following steps.

Prerequisite All users must close the process before it can be deleted.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Workflow.
3. Onthe Workflow tab, select a process and then click Delete.

4. Inthe Delete Process confirmation box, to remove items from the queues in this process and then
delete the process, select the Remove all items from workflow and then delete this process
check box and then click Yes.

Test an alarm

To test an email, icon, or audible alarm that you created in Workflow Designer, complete the following steps.

1. Onthe Perceptive Content toolbar, click the Workflow arrow, point to your process, and then select
the queue where you added the alarm.

2. Verify that there are some workflow items in the queue that meet the conditions you defined in your rule,
and then complete one of the following actions.

Situation Steps

Test an email alarm 1. Check your email account. You should
receive an email with a Subject field of the
name you gave to the alarm and a body text
message such as the following: There are 5
email items in the email queue.

2. Select all the workflow items, right-click,
point to Workflow, and then click Route
Forward.

3. Inthe Route Forward dialog box, select a

queue and then click Route. This clears the
alarm state for the queue.

Test an audible alarm « Verify the sounds plays if the alarm
condition is true.

Test anicon alarm « Verify the Perceptive Content icon flashes if
the alarm condition is true.




Run a script upon opening a workflow item

You can create a VBScript that executes each time a workflow item is open. This is a global script that
executes for all workflow queues in all workflow processes that exist on the ImageNow Server you are
running. To run a script upon opening a workflow item, complete the following steps.

1. Open a workflow item.

2. InlmageNowViewer, click Workflow > Page Load Script.

3. Inthe Workflow Page Load Script dialog box, type in your VBScript, and then click OK.

4. Close theitem, and then in the confirmation box, click Yes.

Share a workflow process with another department

You can enable a workflow process to share among multiple departments. To share a workflow process with
other departments, complete the following steps.

Important: You should cautiously consider the impact of sharing a workflow process, and have a calculated

design and implementation plan in place. Once you share a workflow process, you cannot unshare or delete it
from the system.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Workflow.

3. Intheright pane, select the workflow process you want to share, and then click Share.

4. Inthe Share <process name> dialog box, select the departments you want to share the workflow
process with, and then click OK.

Share a workflow rule with another department

To share a workflow routing or alarm rule with another department, complete the following steps.

Important: You should cautiously consider the impact of sharing a workflow rule, and have a calculated
design and implementation plan in place. Once you share a workflow rule, you cannot unshare or delete it from

the system.
1. InWorkflow Designer, in the Tasks pane, click Actions.
2. Click Manage Actions.

3. Inthe Action Settings dialog box, on the Rules tab, select the rule that you want to share and click
Share.

4. Inthe Share <Rule> dialog box, check the boxes of the departments you want to share the reason list
with and then click OK.

5. Inthe Share <Rule> confirmation dialog box, click OK.
6. Inthe Actions Settings dialog box, click OK.



Manage reasons

What is a reason list?

Reason lists provide users the ability to indicate why they are putting a workflow item on hold.

When putting an item on hold in a workflow queue, users are prompted to select a reason from a reason list.
As manager of a workflow process, you control the contents of every On Hold reason list. You can define a
reason list as part of a workflow queue's properties.

Add a reason list for putting an item on hold

When putting an item on hold in a workflow queue, the user must select the reason for the change from a
reason list. To create and edit a reason list, complete the following steps.

1. Complete one of the following actions, depending on the situation.

Situation Steps

Create a hold reason list in Perceptive Content 1. In Management Console, in the left pane,
under Select Department, select a
department from the list.

2. Inthe left pane, click Workflow.
3. Onthe Reason Lists tab, click New.

Create a hold reason list in Workflow Designer | 1. In Workflow Designer, double-click the
queue.

2. Inthe Queue Properties dialog box, click
Reasons > New.

2. Inthe Reason List dialog box, type a name and optional description for the reason list and then leave
the Is active check box selected.

3. Onthe List Members tab, add, remove, and rearrange reasons as necessary.
4. Click OK.

Modify or rename a reason list for putting an item on hold

Reason lists are created to provide users with predefined reasons for putting workflow items on hold. To
modify a reason list for putting an item on hold, complete the following steps.

1. Complete one of the following actions, depending on the situation.



Situation Steps

Modify a hold reason list in Management 1. In Management Console, in the left pane,
Console under Select Department, select a
department from the list.

2. Inthe left pane, click Workflow.
3. Click the Reason Lists tab.

4. Click the list you want to change and then
click Modify.

Modify a hold reason list in Workflow Designer | 1. Double-click the queue.

2. Inthe Queue Properties dialog box, click
Reasons in the left pane.

3. Inthe Select a reason list to use when
placing items On Hold in this queue list,
click the list you want to change and then
click Modify.

2. Inthe Reason List dialog box, on the General tab, change the name and description if necessary.

Note: You cannot change the name of a system list (Apply Signature, Void/Expire Digital ID, or Void
Signature).

3. Tomake the reason list inactive, clear the Is active check box.
Note: You cannot disable a system list.

4. Inthe List Members tab, add, remove, or rearrange reasons.
5. Click OK.

Share a workflow reason list with another department

You can enable a workflow reason list to share among multiple departments. To share a workflow reason list
with other departments, complete the following steps.

Important: You should cautiously consider the impact of sharing a workflow reason list, and have a
calculated design and implementation plan in place. Once you share a workflow reason list, you cannot
unshare or delete it from the system.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.
2. Intheleft pane, click Workflow.

3. Intheright pane, in the Reason Lists tab, select the workflow reason list you want to share and then
click Share.



4. Inthe Share <Reason list name> dialog box, check the boxes of the departments with which you
want to share the workflow reason list and then click OK.

Delete a reason list for putting an item on hold

To delete a reason list for putting an item on hold, complete the following steps.

You cannot remove a system list (Apply Signature, VVoid/Expire Digital ID, or Void Signature).

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Workflow.

3. Click the Reason Lists tab.

4. Click the reason list you want to delete and then click Delete.

Manage tasks

About administering tasks

To administer tasks in Management Console, you create task templates for your users.

You can assign one or more users a task on a particular document or folder. You choose the task type that
best matches the work that needs to be done. The three available task types are described below.

o Document deficiency. The document deficiency task type is used to indicate when a document is
missing or is incomplete.

« Pointer. The pointertask type is used to draw attention to a specific document or folder location for
further action.

e Signature required on document. The signature required on document task type is used when a
user needs to digitally sign a document. To use this task type, a Document Management Suite license is
required.

Task template security allows you to determine the roles your users have when working with tasks. You can
also manage reasons and reason lists for the task templates.

Signatures required on document tasks created in Management Console are available for processing in
Interact Desktop. In Interact Desktop, you can Complete, Return, or Skip a Signature required on a document
task.



Troubleshoot tasks

If you experience issues using tasks, you can try any of the following possible resolutions.

| don tsee adocumenttaskin Folder Viewer

Cause

Resolution

If you create a document task and then add that
document to a folder, the document task does not
appear in the Tasks grid in Folder Viewer.

Only document tasks you create in Folder Viewer
appear in the Tasks grid in Folder Viewer.

Not all location options are available when | create a task

Cause

Resolution

The task template you are using to create a task
does not have the Task location set in the
Components area of the task template.

Use a different task template or select an available
location option.

When you are in Folder Viewer and do not have a
document open in ImageNowViewer - Folder, the
only Location option available is Folder.

To create a document or page task in Folder Viewer,
the associated viewer, ImageNowViewer- Folder
must be open.

When in ImageNowViewer, Folder is unavailable
because you are not in a folder.

Folder is only available when you create a task in
Folder Viewer.

Task Templates

Create a document deficiency task template overview

Document deficiency task templates define the structure of document deficiency tasks, which indicate when
a document is missing or incomplete. To create and define a document deficiency task template, complete

the following sequence of procedures.

Create a document deficiency task template.
Define task template properties.

Define task template components.

Optional. Define task template actions.
Define task template assignments.

Define task template reasons.

Define task template due date method.

0 N O G b WON -

Define task template security.
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Create a signature required task template

To create a new signature required task template, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Tasks.

3. Intheright pane, on the Templates tab, in the Select a task type box, click Signature required on
document.

4. Click New.
The Signature Required on Document Task dialog box appears.

Next You must define the task template s general properties, components, actions, assignments, reason
lists, due date, and security.

Create a pointer task template overview

To create a pointer task template, complete the following sequence of procedures.

Create a pointer task template.

Define task template properties.

Define task template components.
Optional. Define task templace actions.
Define task template assignments.
Define task template reasons.

Define task template due date method.

0 N O G b WON -

Define task template security.

Result The Incomplete Template dialog box appears if you do not define assignments, reason lists, or if you
opted to send the folder to workflow when the task location is a document in a folder box, but did not select a
queue. You can save this template in any of these states, but the template is set to inactive.

Create a pointer task template

To create a new pointer task template in Management Console, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, in the Select a task type box, click Pointer.

Click New.

In the Pointer Task dialog box, define the task template.

o kw b

Next Define the task template properties, components, actions, assignments, reasons, due dates, and
security.

15



Define task template properties

To define the general properties of a pointer, document deficiency, or signature task template, complete the
following steps.

Prerequisite Before completing this procedure, you must create the task template.

a kv bh-=

7.

Open the task template.

Inthe <Task Type>Task dialog box, in the left pane, click Properties.

In the right pane, under General, in the Name box, type a name for your task template.
Optional. In the Description box, type a template description.

Under Options, verify that the Is active check box is selected to make the task template available to
task creators assigning tasks from the Tasks toolbar.

Optional. Select the Delete completed task check box to automatically and permanently delete a task
and its related history after the task is completed.

If a task creator assigns a task series and this option is selected, Perceptive Content does not delete
the tasks in that series until the series is complete. After a series is complete, that entire series is
removed.

Click OK.

Next Define the task template components, actions, assignments, reasons, due dates, and security.

Define task template components

To define the components of a pointer, document deficiency, or signature task template, complete the
following steps.

Prerequisite Before completing this procedure, you must create the task template and define its general

properties.

1. Open the task template.

2. Inthe <Task Type> Task dialog box, in the left pane, click Components.

3. Intheright pane, under General, in the Task instructions box, type the instructions you want your task
assignees to see.

4. Optional. Select the Modifiable during task creation check box to allow a task creator to modify the
instructions on the Options tab in the New Task dialog box.

5. Inthe Task location section, select one or more of the following locations to determine where tasks

created with this template can be assigned:
o Folder - Create atask for a folder.
« Document - Create a task for a document.

« Page without a visual representation - Create a task for a page in a document with no visual
representation.

« Page with a visual representation - Create a task, along with a visual representation, for a page
in a document.

Note: You must select at least one task location. Not all options are available for Signature Required



task templates.

In the Completion method box, select one of the following methods:
« Manual - After task assignees complete a task, the task status is Complete.

« Complete pending review - After task assignees complete a task, the tasks with this status go
to a reviewer.

If you are defining components for a Signature Required task template, the task completion method is
automatic with a valid digital signature.

Optional. Under Workflow Assignment, do the following substeps:

1. Inthe Send to queue list, select the workflow queue to send the document or folder to after the
task is complete, or select (Prompt) to prompt the task creator for a workflow queue.

Note: Only workflow queues for which you have the Add privilege appear in the list.

2. Ifthetask location is a document in a folder, select the Send the folder to the workflow queue
if the task location is a document in a folder check box to send the folder to workflow.

8. Click OK.
Next You must define the task template actions, assignment, reasons, due date, and security.

Define task template actions

To define the automated actions for a pointer, document deficiency, or signature required task template,
complete the following steps.

Prerequisite Before completing this procedure, you must create the task template and define its general
properties and components.

Open the task template.
Inthe <Task Type> Task dialog box, in the left pane, click Actions.

In the right pane, under Scripting, complete any of the following actions to apply an iScript to tasks
with the following statuses:

« Forassigned tasks, in the Assigned list, select an iScript.

« Forreturned tasks, in the Returned list, select an iScript.

« For complete pending review tasks, in the Pending review list, select an iScript.
« Forcomplete tasks, in the Complete list, select an iScript.

« Forcanceled tasks, in the Canceled list, select aniScript.

« Forinvalid tasks, in the Invalid list, select aniScript.

Optional. To send an email notification to task assignees when a task is created with this template,
under Notifications, select the Send email notification when task is created check box.

Note: A task assignee must have an email address configured in the user profile in order to receive an
email notification.



5. Optional. Toinclude a Perceptive Content link, select the Include Perceptive Content link check
box.

6. Click OK.
Next You must define the task template assignments, reasons, due date, and security.

Define task template assignments

To define the user or group assignments for a pointer, document deficiency, or signature required task
template, complete the following steps.

Prerequisite Before completing this procedure, you must create the task template and define its general
properties, components, and actions.

Open the task template.

In the <Task Type> Task dialog box, in the left pane, click Assignment.

In the right pane, click Add.

A ON -

In the Select Users and Groups dialog box, do the following substeps:

1. Toadd auser, on the Users tab, search for and select a user and click Add.

2. Toadd a group, on the Groups tab, search for and select a group and click Add.
3. Addas many users or groups as necessary.

4. Click OK.

Note: The Assignment List must include at least one user or group for the task template to be
active.

5. Optional. Select the Automatically assign the task to the task creator check box.
6. Click OK.
Next You must define the task template reasons, due date, and security.

Define task template reasons

To define the reason list to appear for tasks created with a pointer, document deficiency, or signature requires
task template, complete the following steps.

Prerequisite Before completing this procedure, you must create the task template and define its general
properties, components, actions, and assignments.

Open the task template.

In the <Task Type>Task dialog box, in the left pane, click Reasons.

Optional. Under Action Reasons, in the Action list, select the action list to display.

A ON -

Optional. To require task assignees to select a reason after completing a task, select the Assignee
must specify a reason during task completion check box.

Note: This option is not available for signature required task templates.



5. Under Return Reasons, in the Return list, select a return list.
6. Click OK.
Next You must define the task template due date and security.

Define task template due date method

To define the due date method in a pointer, document deficiency, or signature required task template,
complete the following steps.

Prerequisite Before completing this procedure, you must create the task template and define its general
properties, components, actions, assignments, and reason lists.
1. Open the task template.
2. Inthe <Task Type>Task dialog box, in the left pane, click Due Date.
3. Intheright pane, under Due Date Calculation, do one of the following actions:

Situation Steps
Calculate due date based on task assignment 1. Inthe Method list, click Based on
date assignment date.

2. Inthe Days box, set the number of days
after the assignment date.

Calculate due date based on task start date 1. Inthe Method list, click Based on start
date.
2. Inthe Days box, set the number of days
after the start date.
Define no due date « Inthe Method list, click No due date.
Prompt task creator to define due date « Inthe Method list, click Prompt task

creator for date.

4. Click OK.
Next You must define the task template security.

Define task template security

To define the user and group security for a pointer, document deficiency, or signature required task template,
complete the following steps.

Prerequisite Before completing this procedure, you must create the task template and define its general
properties, components, actions, assignments, reason lists, and due date.

1. Open the task template.
2. Inthe <Task Type> Task dialog box, in the left pane, click Security.



8.

In the right pane, click Add.

In the Select Users and Groups dialog box, do the following substeps:

1. Toadd auser, on the Users tab, search for and select a user and click Add.

2. Toadd agroup, on the Groups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.

4. Click OK.

Under Users and Groups, select a user or group.

To grant the user or group the following privileges, click the column in front of each privilege until it
appears or click Allow All.

« Toallow the user or group to create tasks with this template, grant the Create privilege.
« Toallow the user or group to delete tasks created with this template, grant the Delete privilege.
« Toallow the user or group to manage this template, grant the Manage privilege.

« Toallow the user or group to view and modify returned tasks created with this template, grant the
Manage Returned privilege.

« Toallow the user or group to modify tasks created with this template, grant the Modify privilege.

« Toallow the user or group to review tasks created with this template after they have been
completed by a task assignee, grant the Review privilege.

« Toallow the user or group to view, but not process or modify tasks created with this template,
grant the View privilege.

Note: The View privilege is not required for task assignees. The user or group assigned to a task
automatically has the ability to view that task.

If you want task creators to review the tasks they create, select the Automatically grant task
creators the Review privilege for the tasks they create check box.

Click OK.

Modify a task template overview

To make changes to a task template, complete the following steps.

0 N O O b WON -

Open a task template.

Define task template properties.
Define task template components.
Optional. Define task template actions.
Define task template assignments.
Define task template reasons.

Define task template due date method.
Define task template security.

20



Copy a task template

Task templates specify various options for task creation. To copy a task template, complete the following
steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, in the Select a task type box, click a task type.

In the Templates list, click a template and then click Copy.

In the Name column, type a name and then press ENTER.

a kb

Rename a task template

To assign a new name to a task template, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, in the Select a task type box, click a task type.
In the Templates list, click a template and click Rename.

o kb

In the Name column, type the text of the template name and then press ENTER.

Delete a task template

When you delete a task template, Perceptive Content removes the template from Management Console but
retains all associated tasks. To delete a task template, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, in the Select a task type box, click a task type.

In the Templates list, click a template and then click Delete.

In the Task Template dialog box, click Yes.

o kb

Configure task email notifications
To configure the options required for task creation email notifications, complete the following steps.
1. Toadd email addresses so that users can receive task creation notifications, perform the following

substeps.

1. In Management Console, in the left pane, under Select Department, select a department from
the list.

In the left pane, select Users.

In the right pane, on the User Profiles tab, select the user for whom you want to add an email
address and then click Modify.
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In the Modify User Profile dialog box, in the left pane, select Contact Information.
In the right pane, in the Email box, type the user's email address.

Click OK.

Define email addresses for all necessary users.

Noe o s

Optional. To include Perceptive Content links in task email notifications, perform the following
substeps.

1. OnthelmageNow Server computer, navigate to the [drive:]\inserver\etc folder.
2. Open the inserverNotification.ini file in a text editor.
3. Inthe Email section, configure the smtp. server setting.

Example smtp.server=<SMTP server name or IP address>
4. Configure the smtp.server.port setting.

Example smtp.server.port=<Port number> By default, the port number is 25.
5. Configure the smtp. from address.

Example smtp. from=<From address for email notifications>

6. Save and close the inserverNotification.ini file.

Result All task templates use the same Perceptive Content settings.

Share a task template with another department

You can enable a task template to be shared among multiple departments. To share a task template with
other departments, complete the following steps.

Important: You should cautiously consider the impact of sharing a task template, and have a calculated
design and implementation plan in place. Once you share a task template, you cannot unshare or delete it
from the system.

1.

In Management Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, select the task template you want to share and then click
Share.

In the Share <template name> dialog box, check the boxes of the departments you want to share the
task template with and then click OK.
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Task Reasons

About managing task reason lists

Reasons provide users with pre-set descriptions that they can select to indicate why they are signing,
completing, or returning a task.

A reason list is a set of reasons that you, the administrator, bundle as a list from which the user can select.
There are two types of reasons and reason lists: Action and Retun. While Return reasons are required for
each task template type, Action reasons are optional for document deficiency and pointer task template
types.

Manage reasons

You can create reasons and then group them together in reason lists. You can assign reasons and reason lists
to tasks, workflow item holds, or digital signatures. To create, modify, or delete a reason, complete one of the
following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.
2. Inthe left pane, complete one of the following steps.

1. Tomanage reasons for tasks or workflow item holds, under Select Department, select a
department from the list.

2. Tomanage reasons for digital signatures, under Select Department, select Cross Department
Settings.

3. Inthe left pane, click Tasks, Workflow, or Digital Signatures.
4. Intheright pane, on the Reason Lists tab, select a reason list and click Modify.
5. Inthe Reason List dialog box, on the List Members tab, complete one of the following actions.

Situation Steps

Create a reason 1. Click New.

2. Inthe Reason text box, type a name.

Modify a reason 1. Select a reason and click Modify.

2. Inthe Reason text box, type a new name.

Delete a reason 1. Select a reason and click Delete.
2. Inthe Delete Reason confirmation box,
click Yes.

Result Changes you make to the available reasons apply to all departments.
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Modify a reason list

Reason lists are used when you define action and return reasons in document deficiency and pointer task
templates. To modify an reason list for a task template, complete the following steps.

1.

w N

Manage a reason list for a task template

® N o &

In Management Console, in the left pane, under Select Department, select a department from the

list.
In the left pane, click Digital Signatures.

In the right pane, on the Reason Lists tab, perform one of the following actions, depending on the

situation.
Select the reason list and click Modify.

In the Reason List dialog box, on the General tab, change the name or description.
To enable or disable the list, clear or select the Is active check box.
On the List Members tab, in the Selected list, add, remove, or rearrange reasons.

Click OK.

Reason lists are used when you define action and return reasons in document deficiency and pointer task
templates. To create, modify, or delete a reason list for a task template, complete one of the following

In Management Console, in the left pane, under Select Department, select a department from the

procedures.
1.
list.
2. Intheleft pane, click Tasks.
3.

In the right pane, on the Reason Lists tab, do one of the following actions, depending on the situation:

Situation Steps
Create areason list 1. Click New.
2. Inthe Reason List dialog box, on the

General tab, type a name and optional
description.

3. Verify that the Is active check box is
selected to make the list available for
assignment.

4. Onthe List Members tab, add, remove, or
rearrange reasons.

5. Click OK.

Modify a reason list 1. Click Modify.
2. Inthe Reason List dialog box, on the

General tab, modify the name or optional
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Situation Steps

description.

3. Toenable or disable the reason list, clear or
select the Is active check box.

4. Onthe List Members tab, add, remove, or
rearrange reasons.

5. Click OK.

Delete a reason list 1. Click Delete.

2. Inthe Delete Reason List confirmation
box, click Yes.

Manage action reason lists for a signature required task template

To create, modify, or delete an action reason list for a signature-required task template, complete the following
steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Inthe left pane, under Select Department, select Cross Department Settings from the list.

3. Inthe left pane, click Digital Signatures.

4. Intheright pane, on the Reason Lists tab, perform one of the following actions, depending on the

situation.
Situation Steps
Create a reason list 1. Click New.

2. Inthe Reason List dialog box, on the
General tab, type a name and optional
description.

3. Verify that the Is active check box is
selected to make the list available for
assignment.

4. Optional. On the List Members tab, in the
Available list, create, modify, or delete
reasons.

5. Onthe List Members tab, in the Selected
list, add, remove, or rearrange reasons.

6. Click OK.
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Situation

Steps

Modify a reason list

Click Modify.

2. Inthe Reason List dialog box, on the
General tab, change the name or
description.

3. Toenable or disable the list, clear or select
the Is active check box.

4. Optional. On the List Members tab, in the
Available list, create, modify, or delete
reasons.

5. Onthe List Members tab, in the Selected
list, add, remove, or rearrange reasons.

6. Click OK.

Delete a reason list

Select areason list and click Delete.

2. Inthe Delete Reason List confirmation
box, click Yes.

Share a task reason list with another department

You can enable a task reason list to share among multiple departments. To share a task reason list with other
departments, complete the following steps.

Important: You should cautiously consider the impact of sharing a task reason list, and have a calculated
design and implementation plan in place. Once you share a task reason list, you cannot unshare or delete it

from the system.

1. InManagement Console, in the left pane, under Select Department, select a department from the

list.

2. Intheleft pane, click Tasks.
3. Intheright pane, in the Reason Lists tab, select the task reason list you want to share and then click

Share.

4. Inthe Share <Reason list name> dialog box, check the boxes of the departments with which you

want to share the task reason list and then click OK.
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Manage views

About administering views

As a department manager, you create views that display only the content with which your users need to work.

By tailoring your user's view to only the items they need to see, you simplify their user experience. While the
system may contain hundreds or thousands of items and other types of content, your users see only the
subset of items that you enable in their view. Views enable you to add another layer of protection to content.
In addition to the access privileges set for drawers, file plans, and item types, your users can see the item
within a particular drawer, file plan, or type that satisfies the view definition.

You can also use a view to create a report if you have Business Insight installed in your environment.

To view records functionality, you must install a Records Manager license.

About administering related views

A user can display one or more related views from a viewer in Perceptive Content. When the user selects a
related view to apply to the active document or folder, the Related Documents or Related Folders pane
displays other items that match the items with respect to the conditions you define for the related view.

Users with document or folder view management privileges can create, rename, and delete related views in
Perceptive Content. When you modify a related view, you automatically enter Perceptive Content View
Designer, where you can create or modify relationship conditions, activate the view, and assign security
settings toit.

Suppose, for example, you view a student information document with a Field2 value that contains the
student's ID number. You want to see all the other documents with the same Field2 value. You can create the
condition for this relationship, and the Related Documents pane displays any other documents that have a
Field2 value that match the student ID number in the active document.

As another example, suppose you view an inventory document with a custom property that contains a check
number. Another set of business documents contains a check number in Field3 rather than in a custom
property. You want to see all documents with a Field3 value that matches the Check Number custom property
in the active document. You can create the conditions for this relationship, and the Related Documents pane
displays any other documents that have a Field3 value that matches the Check Number custom property in
the active document.

For folders, related views are like related views for documents except that the relationship matches on folder
properties. For example, suppose you work at a hospital and your Perceptive Content environment is set up
so that each time a patient visits the hospital, a new folder is created. The new folder contains all documents
related to that visit. If a patient makes a return visit, that patient will have two folders created, one for each
visit. You view a recent patient's visit and realize you need to see all other folders from past visits. You can
create the conditions for this relationship, view all folders that correspond to the patient's identification code,
and open any folders that you need to view.



Types of views

The following list summarizes views available in Perceptive Content, including views created by you, your
view manager, and views created automatically by the Perceptive Content system.

Application Plan

An application plan view returns a set of documents captured using a specific application plan. Application
plans that do not have a defined view action do not display results.

Modifiable components
View conditions
Column layout
View statistics
Sorting and grouping

Security considerations

Users with application plan management privileges can modify application plan views, including view
actions and components, in Application Plan Designer.

Users with the View privilege for the application plan can run the view. For the active business
application plan screen, the view returns the associated results.

Batches

A batch view retumns the batches in your Perceptive Content system. By default, batch users can see all
batches, batches that are ready for QA, and batches that are ready for linking.

Modifiable components
Column layout

Sorting and grouping

Document

A document view returns a set of documents. Document views appear in the Views pane under Documents.
Modifiable conditions

View name

View privileges

View conditions

Public filters

Private filters
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Column layout
View statistics

Sorting and grouping

Security considerations

Users with view access can run a document view.

File Plans

A file plan view returns a set of records within a particular record category or record folder. File plan views
appear in the Views pane under File Plans, and are organized according to the hierarchy of file plans, record
categories, and record folders in the system. When you select one of these items, Perceptive Content
retrieves the set of records within that item.

ImageNowExplorer uses the system-defined view and it cannot be modified. You can modify a view during a
viewing session, but you can t create and save filters or views for file plan view.

File plan view does not use Quick Search, only Advanced Search.
Modifiable components

View conditions

Column layout

Sorting and grouping

Security considerations

In the views tree, users see only the file plans for which they have been granted Search privileges, and
the record categories and record folders for which they have been granted Use privileges.

Folder

A folder view returns a set of folders. Folder views appear in the Views pane under Folders.
Modifiable conditions

View name

View privileges

View conditions

Public filters

Private filters

Column layout

View statistics

29



Sorting and grouping

Security considerations

Users with view access can run a folder view.

Folder content

When the user opens a folder, Folder Viewer displays a secondary grid that lists the folder's contents. This
secondary grid is called a folder content view. Because document and folder shortcuts can belong to any
number of folders, the same document or folder might appear as a representation in Folder Viewer with
different grid layouts, depending on the type of folder the user opens.

Changes you make apply to all folders associated with the modified folder type. Because you can represent a
document or folder using shortcuts in any number of folders, the same item might appear in a folder content
view with different grid layouts, depending on the folder's type.

Modifiable conditions
Column layout
View statistics
Sorting and grouping
Security considerations

Users with folder type management privileges can modify components of the folder content view in
Management Console.

Recently received documents

Recently received documents appear in a temporary view that appears when one Perceptive Content user
transfers documents to another user with the Send to User feature. This transfer must occur while both users
are connected to the same ImageNow Server. The view sorts the received documents according to the name
of the sending user and the time they were sent.

Record

To view records functionality, you must install a Records Manager license.

A record view retumns a set of records. Record views appear in ImageNowEXxplorer, in the Views pane under
Records.

Modifiable conditions
View name
View privileges

View conditions
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Public filters
Private filters
Column layout
View statistics

Sorting and grouping

Security considerations

Users with view access can run a record view.

Record Folder

A record folder view returns a set of record folders and record categories. Record Folders views appear in
ImageNowEXxplorer, in the Views pane under Record Folders.

Modifiable conditions
View name
View privileges
View conditions
Public filters
Private filters
Column layout
View statistics

Sorting and grouping

Security considerations

Users with view access can run a record folder view.

Record Folder Content

When the user opens a record folder, Record Folder Viewer displays a secondary grid that lists the folder s
contents. This secondary grid is called a record folder content view. Because record folder shortcuts can
belong to any number of record folders, the same record folder might appear as a representation in Record
Folder Viewer with different grid layouts, depending on the type of record folder the user opens. Changes you
make apply to all record folders associated with the modified record folder type.

Modifiable conditions
Column layout

View statistics
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Sorting and grouping

Security considerations

Users with record folder management privileges can modify components of the record folder content
view in Management Console.

Recycled documents and document folders

When the user deletes a document or folder, Perceptive Content moves the item to a system view called My
Recycled Documents or My Recycled Folders.

Items remain in the recycled view for the number of days that you specify in the inserverFS.inifile.
Modifiable conditions

Private filters

Security considerations

If the user is a Department Manager, two additional views appear. These views, All Recycled
Documents and All Recycled Folders, display all items deleted by all users. As long as the user can see
arecycled document or folder, the user can restore it to its previous state, at which time the document or
folder keeps the attributes it had before deletion, if possible.

Related

Related views appear in the Related Documents pane of the document viewer and in the Related Folders
pane of the folder viewer. A related view applies the relationship selected in the list to the current document or
folder. The view displays a list of all documents or folders that satisfy the conditions of the relationship.

Modifiable conditions
Relationship name
View privileges
View conditions
Public filters
Private filters
Column layout
View statistics

Sorting and grouping

Security considerations
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Users with document view management privileges can create and modify document relationships in
Management Console. Users with folder view management privileges can create and modify folder
relationships in Management Console.

Task

A task view returns a list of tasks assigned to the user according to the type of task, such as My Assigned or
To Review. Task views appear in the Views pane under Tasks.

Modifiable conditions
Public filters
Private filters
View statistics
Column layout

Sorting and grouping

Workflow process

A workflow process view returns a list of items (representing documents or folders) when the user accesses a
workflow process, which appears in the Views pane under Workflow.

Modifiable conditions

Private filters

Security considerations

Workflow process views appear automatically depending on the workflow queues for which a user has
the necessary privileges. Users with workflow process management privileges can modify workflow
queue view components in Workflow Designer.

Security considerations

Users with view access can run a folder view.

Workflow queue

A workflow queue view returns a list of items (representing documents or folders) when the user accesses a
workflow queue, which appears in the Views pane under Workflow.

Modifiable conditions
Column layout
View statistics
Private filters

Grouping and sorting
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Security considerations

Workflow queue views appear automatically depending on the workflow queues for which a user has the
necessary privileges. Users with workflow process management privileges can modify workflow queue
view components in Workflow Designer.

Supported file formats for Perceptive Content

The following tables list the file formats that ImageNowViewer support.

Archive file formats

Format Version Extension

7-Zip 4.57 7Z

BinHex N/A HQX

GzZIP 2 Gz

Java Archive N/A JAR

Microsoft Cabinet Format 1.3 CAB

Microsoft Compressed Folder N/A LZH, LHA

PKZIP Through 9.0 ZIP

RAR Archive 2.0 through 3.5 RAR

Tape Archive N/A TAR

Unix Compress N/A Z

UUEncoding All versions UUE

WinZip Through 10 ZIP
Binary file formats

Format Version Extension

Executable N/A EXE




Format Version Extension

Link Library N/A DLL
Database file formats

Format Version Extension

Microsoft Access 95, 97, 2000, 2002, 2003 MDB
Display file formats

Format Version Extension

Adobe PDF Through 9 PDF
Graphic file formats

Format Version Extension

Computer Graphics Metafile N/A CGM

CorelDRAW Through 9.0 CDR

DCX Fax System N/A DCX

Digital Imaging and N/A DCM

Communications in Medicine

Encapsulated PostScript (raster) TIFF header EPS

Enhanced Metafile N/A EMF

GIF 87,89 GIF

JPEG N/A JPEG, JPG

Lotus AMIDraw Graphics N/A SDW




Format Version Extension
Lotus Pic N/A PIC
Macintosh Raster 2 PIC, PCT
MacPaint N/A PNTG
Microsoft Office Drawing N/A MSO
PC PaintBrush 3 PCX
Portable Network Graphics N/A PNG
Sun Raster Image N/A RS
Tagged Image File Through 6.0.3 TIFF
Truevision Targa 2 TGA
Windows Animated Cursor N/A ANI
Windows Bitmap N/A BMP
Windows Icon Cursor N/A ICO
Windows Metafile 3 WMF
WordPerfect Graphics 1 1 WPG
WordPerfect Graphics 2 2,7 WPG
Mail file formats
Format Version Extension
Lotus Notes database 4,5,6.0,6.5 NSF
Microsoft Outlook 97, 2000, 2002, 2003 MSG
Microsoft Outlook Personal 97, 2000, 2002, 2003 PST

Folder




Multimedia file formats

Any audio or movie format supported by Apple QuickTime or Windows Media Player. For specific formats
supported by these players, refer to the respective Apple or Microsoft websites. Depending on your hardware

and network, large movie files (over 100 MB) may slow performance.

Presentation file formats

Format Version Extension
Applix Presents 4.0,4.2,4.3,4.4 AG

Corel Presentations 6,7,8,9, 10, 11, 12, X3 SHW

Lotus Freelance Graphics 2 2 PRE

Lotus Freelance Graphics 96, 97, 98, R9, 9.8 PRZ

Microsoft PowerPoint Macintosh 98, 2001, 2004 PPT, PPS, POT

Microsoft PowerPoint PC 4

PPT, PPS, POT, PPTX, PPTM,
POTX, POTM, PPSX, PPSM

Microsoft PowerPoint Windows 95, 97, 2000, 2002, 2003, 2007

PPT, PPTM, PPTX

Spreadsheet file formats

Format Version Extension
Applix Spreadsheets 42,4.3,44 AS
Comma Separated Values N/A Csv

Corel Quattro Pro 56,7,8 wB2, WB3
Lotus 1-2-3 96, 97, R9, 9.8 123

Lotus 1-2-3 2,3,4,5 WK4
Lotus 1-2-3 Charts 2,3,4,5 123
Microsoft Excel Charts 2,3,4,5,6,7 XLS




Format

Version

Extension

Microsoft Excel Windows

2.2 through 2007

XLS, XLSM, XLSX, XLW, XLT,
XLA, XLTX, XLTM, XLAM

Microsoft Excel Macintosh 98, 2001, v.X, 2004 XLS
Microsoft Works Spreadsheet 1,2,3,4 S30, S40
OASIS Open Document Format 1,2 ODS, SXC, STC
OpenOffice Calc 1, 1.1 SXC, ODS, OTS
StarOffice Calc 6,7 SXC, ODS
Text and Markup file formats
Format Version Extension
ANSI N/A TXT
ASCII N/A TXT
HTML 3,4 HTM
Microsoft Excel Windows XML 2003 XML
Microsoft Word Windows XML 2003 XML
Rich Text Format 1 through 1.7 RTF
Unicode Text 3,4 TXT
Note: Specific support is only
applicable to the Unicode
version.
UTF-8 N/A TXT
UTF-8 - No Byte Order Mark N/A TXT

(BOM)




Format Version Extension
UTF-16 Little Endian (UTF-16LE) | N/A TXT

Note: A BOM is required for the

UTF-16LE format to be read

correctly.
XHTML 1 HTM, XHTML
XML 1.0 XML

Word processing file formats

Format Version Extension
Adobe FrameMaker Interchange 555,6,7 MIF
Format
Applix Words 3.11,4,4.1,4.2,43,44 AW
Corel WordPerfect Linux 6.0, 8.1 WPS
Corel WordPerfect Macintosh 1.02,2,2.1,2.2, 3, 3.1 WPS
Corel WordPerfect Windows 5,5.1 WO, WPS
Corel WordPerfect Windows 6,7,8,9, 10, 11, 12, X3 WPD
DisplayWrite 4 IP
Folio Flat File 3.1 FFF
Fujitsu Oasys 7 OA2
IBM DCA/RFT (Revisable Form SC23-0758 -1 DC
Text)
JustSystems Ichitaro 8 through 2005 JTD
Lotus AMI Pro 2,3 SAM




Format Version Extension
Lotus AMI Professional Write 21 AMI

Plus

Lotus Word Pro 96, 97, R9 LWP
Lotus SmartMaster 96, 97 MWP
Microsoft Word PC 4,5,5.5,6 DOC

Microsoft Word Windows

1.0, 2.0, 6, 7, 8, 95, 97, 2000,

DOC, DOCX, DOCM, DOT,

2002, 2003, 2007 DOTX, DOTM

Microsoft Word Macintosh 4,5, 6, 98, 2001, v.X, 2004 DOC, DOT
Microsoft Works 1,2, 3,4,6,2000 WPS
Microsoft Windows Write 1,2,3 WRI
OASIS Open Document Format 1,2 ODT, SXW, STW
Wordpad Through 2003 RTF
XyWrite 4.12 XY4

Work with Views

Create a view

To create a new view, complete the following steps.

1. InManagement Console, in the left pane, click Views.

2. Intheright pane, click the appropriate tab, and then click New.

3. Inthe New View dialog box, define a name and description for this view and click OK.

Next Modify the view in View DesignerManagement Console to define conditions, column layout, filters, and

view security.

Create arelated view

To create a relationship view for an item, perform the following steps.

1. InManagement Console, in the left pane, click Relationships.
2. Intheright pane, on the Related tab, click New.



3. Inthe New Relationship dialog box, type a name and an optional description of the view that appears
in the Tool Tip for the view, and then click OK.

Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Copy a view

You can copy a view to create a new view with the same conditions, filters, column layout, and security
settings. To copy a view, perform the following steps.

You cannot copy a task view.

1. InManagement Console, in the left pane, click Views.
2. Onthe appropriate tab, select the view definition and click Copy.
To view records functionality, you must install a Records Manager license.
3. Inthe Copy View dialog box, type a name and optional description for the new view.

4. Optional. To copy public filters associated with the original view definition, select the All public
filters check box.

5. Optional. To copy users and the view privileges associated with the original view definition, select the
All users and their privileges check box.

6. Optional. If you included users and you also want to copy any private filters created by those users,
select the Private filter for users check box.

7. Click OK.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Copy a related view
To copy a relationship view for an item, complete the following steps.

1. In Management Console, in the left pane, click Relationships.

2. Intheright pane, click the Related tab.

3. Select the relationship and click Copy.

Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Delete a view

To delete a view, perform the following steps.

1. InManagement Console, in the left pane, click Views.

2. Onthe Document, Folder, Record, or Record Folder tab, select the view and click Delete.
To view records functionality, you must install a Records Manager license.

3. Inthe confirmation dialog, click Yes.

Result Users will not see the view removed until they log out and log in again.
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Delete a related view

To delete a relationship view for a document, complete the following steps.

1. InManagement Console, in the left pane, click Relationships.
2. Intheright pane, click the Related tab.

3. Select the relationship and click Delete.

4. Inthe confirmation dialog box, click Yes.

Rename a view

To rename a view, complete the following steps.

You can also rename a view by editing its properties in View Designer. You cannot rename a task view.

In Management Console, in the left pane, click Views.

In the right pane, on the appropriate tab, select the view you want to rename and click Rename.
In the Rename View dialog box, type the new view name and an optional description.

Click OK.

A OON -

Rename a related view

To rename a relationship view for documents or folders, complete the following steps.

In Management Console, in the left pane, click Relationships.
In the right pane, click the Related Documents or Related Folders tab.
Select the relationship and click Rename.

A OON -

In the Rename Relationship dialog box, type the new name of the relationship in the Name box.

Modify a view
To modify components of a view, complete the following steps.

Prerequisite It is recommended that you perform view modifications when no users are signed in to
Perceptive Content.

1. InManagement Console, in the left pane, click Views.
2. Intheright pane, on the appropriate tab, select the view you want to change and click Modify.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Modify a related view

To modify a relationship view for an item, complete the following steps.

Prerequisite It is recommended that you perform view modifications when no users are signed in to
Perceptive Content.

1. InManagement Console, in the left pane, click Relationships.
2. Intheright pane, click the Related tab.
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3. Select the relationship and click Modify.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Version control status indicators

Any document added to version control, either in its current version or in a previous version, is accompanied
by a status indicator in the document search results grid, in the Version Controlled column. If your view does
not show this column, you can temporarily display it or you can add the column in a private filter.

None

The document is not version controlled.

Checked In

The document is version controlled but not currently checked out to any users.

Checked Out

This document is version controlled and currently checked out by another user.
Checked Out by You

£

il

This document is version controlled and currently checked out by you.

If a document is checked in, but marked private by another user, the Is Private icon . appears inthe Is
Private column in the document search results grid.

Configure recycle bin views

You can determine the amount of time an item appears in the recycle bin views in ImageNowExplorer before
permanently deleting it. To configure recycle bin views, complete the following steps.

The following recycle bin views are available to configure: My Recycled Documents, My Recycled Folders,
All Recycled Documents, and All Recycled Folders.
1. Open the [drive:]\inserver\etc\inserverFS.ini file with a text editor.

2. Todetermine the number of days you want items to remain in the recycled views before they are
permanently removed from ImageNow Server, under [General], perform one of the following actions
for the destruction.wait.time setting.

« Toimmediately delete items from the recycle bin, enter 0.
« Todelete items from the recycle bin after a specific number of days, enter the number of days.
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Note: You cannot enter a negative integer. The maximum number of days you can retain items in a
recycle bin view is 2,147,483,647.

3. Save and close the inserverFS.ini file.
4. Restart the File System Agent service.

Set the system default view

You can set the system-wide default view to use a link that does not specify which view to use, and the user
does not have a default view configured. To set the system default view, complete the following steps. You
must be a department manager to set the default system view.

You can also set the default view on a per-user basis in Management Console.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, select Views.

In the right pane, select the System Defaults tab.
In the Document view list, select a default document view.

o kb

In the confirmation prompt, click Yes.
Note: Select None from the list to remove the default document view.

6. Inthe Folder view list, select a default folder view.
7. Inthe confirmation prompt, click Yes.

Note: Select None from the list to remove the default folder view.

Folder content search conditions

When you display the Search pane on the Content tab of Folder Viewer, several conditions are available. The
Add Condition dialog box allows you to build a search using a combination of constraints, fields, operators,
and values described in the following table.

If you are performing a variable search, you can select one of the following values to use as a variable for the
current user: user name, first name, last name, title, organization, organization unit, locality, or user ID. You
can also use the current date and time as a variable.

Composite property

The Composite property constraint allows the following operators: is equal to, is not equal to, is less
than, is greater than, is less than or equal to, is greater than or equal to, starts with, does not start with,
ends with, does not end with, contains, does not contain, is blank, is not blank is one of, is not one of, is
between, and is not between.

The composite properties, which can contain all possible values, are defined by your administrator.
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You can select a composite property is the Composite list, or you can select a custom property in the

Field list.

Custom property

The Custom property constraint allows the following operators: is equal to, is not equal to, is less than,
is greater than or equal to, starts with, does not start with, ends with, does not end with, contains, does
not contain, is blank, is not blank, is one of, is not one of, is between, is not between, is equal to, is not

equal to

Constraint

Operators

Field

Field
Description

Possible Values

Composite
property

is equal to, is not
equal to, isless
than, is greater
than, is less than
orequal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

In the Composite
list, select a
composite
property. In the
Field list, select a
custom property.

Composite
properties are
defined by your
administrator.

All defined
composite
properties

Content property

is equal to, is not
equal to, isless
than, is greater
than, is less than
orequal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not

Content type

The type of
content in the
folder.

« Document

« Document
Shortcut
Folder

« Folder
Shortcut




Constraint Operators Field Field Possible Values
Description
between

Added to folder The number of Type any positive

within (days) days within which integer.
the document,
folder, or shortcut
was added or
moved to the
folder.

Created within The number of Type any positive

(days) days within which integer.
the document,
folder, shortcut
was created.

Name The name value of | Type any
the document, alphanumeric
folder, or shortcut. | value.

Drawer The drawer value Type any
associated with alphanumeric
the document, value.
folder, oritem
referenced by a
shortcut.

Document ID The unique ID of Type any
the document. alphanumeric

value.

Field1 The Field1 value Type any
associated with alphanumeric
the document or value.
document
referenced by a
shortcut.

Field2 The Field2 value Type any

associated with
the document or
document
referenced by a

alphanumeric
value.




Constraint Operators Field Field Possible Values
Description
shortcut.
Field3 The Field3 value Type any
associated with alphanumeric
the document or value.
document
referenced by a
shortcut.
Field4 The Field4 Type any
associated with alphanumeric
the document or value.
document
referenced by a
shortcut.
Field5 The Field5 Type any

associated with
the document or
document
referenced by a
shortcut.

alphanumeric
value.

Document type

The document
type associated
with the document

Type any
alphanumeric
value.

or document
referenced by a
shortcut.
Folder ID The unique ID of Type any
the folder. alphanumeric
value.
Folder type The folder type Type any

associated with
the folder or folder
referenced by a
shortcut.

alphanumeric
value.

Custom property

is equal to, is not
equal to, isless

Select a custom
property.

Custom properties
are defined by
your administrator.

All defined custom
properties




Constraint

Operators

Field

Field
Description

Possible Values

than, is greater
than, is less than
orequal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

Date

is equal to, is not
equal to, isless
than, is greater
than, is less than
or equal to, is
greater than or
equal to, is one of,
is not one of, is
between, is not
between

Added to folder

The date the
content was added
or moved to the
folder.

Type or select a
date value.

Checked out

The date the
document or
document
referenced by a
shortcut was
checked out in
version control.

Type or select a
date value.

Created

The date the
document, folder,
or shortcut was
created.

Type or select a
date value.

Last viewed

The date the
content was last
viewed by a user.

Type or select a
date value.




Constraint Operators Field Field Possible Values
Description
Modified The date the Type or select a
document, folder, date value.
or shortcut was
last modified.
Status changed The date the Type or select a
folder's active or date value.
inactive status
changed.
Document Status is equal to, is not Digital signature The status of the Valid, Invalid,

equal to

status

version controlled
digital signature of
the document.

Void, Not Signed

Has hold applied

Whether the
document has a
direct or inherited
retention hold
applied.

Yes, No

Has physical
reference

Whether the
document had a
physical file
reference.

Yes, No

Is private

Whether the
document is
marked private in
version control.

Yes, No

Is version
controlled

Whether the
document is
added to version
control.

Yes, No

Folder Status

is equal to, is not
equal to

Folder status

The active or
inactive status of
the folder.

Active, Inactive

Has required
documents

Whether the folder
has required
document types.

Yes, No




Constraint Operators Field Field Possible Values
Description
Physical property is equal to In the Template Physical file Template: All
is not equal to, is list, select a templates and physical file
less than, is physical file physical properties | templates the user

greater than, is
less than or equal
to, is greater than
or equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

template. In the
Field list, select a
physical property.

are defined by
your administrator.

can access, Field:
All physical
properties
associated with
the template

User

is equal to, is not
equal to, starts
with, does not
start with, ends
with, is blank, is
not blank, is one
of, is not one of

Checked out by

The user who has
the document
checked out in
version control.

Type an
alphanumeric
value. Any valid
user name.

Created by

The user who
created the
document, folder,
or shortcut.

Last viewed by

The user who last
viewed the
document, folder,
or item referenced
by a shortcut.

Modified by

The user who last
modified the
document, folder,
or shortcut.

Private by

The user who




Constraint

Operators

Field

Field
Description

Possible Values

marked the
document private
in version control.

Status changed by

The user who last
changed the folder
status.

Workflow item
property

is equal to, is not
equal to, isless
than, is greater
than, is less than
orequal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

Is in workflow

Whether the
document or folder
is added to
workflow.

Yes, No

Workflow queue

The workflow
queue associated
with the
document, folder,
or item referenced
by a shortcut.

Type an
alphanumeric
value.

Workflow item
user

The user who
added the
document, folder,

Type an
alphanumeric
value. Any valid

oritem referenced | user name.
by a shortcut to
workflow.
Workflow item The status of the Idle, Working, On

status

document, folder,
or item referenced
by a shortcut in
workflow.

hold, Pending,
Waiting for
routing, Waiting
for inbound action




Sort view or search results

You can sort the rows in the results grid for a view or public filter. To sort view results, complete the following
steps.

1.

3.
4.

In the view preview or search results grid, to sort by a single column, right-click the column heading and
then do one of the following:

« Tosort the results in ascending order, select Sort Ascending.
« Tosort the results in descending order, select Sort Descending.

To sort by additional columns, hold the SHIFT key and click the column heading once to sort the results
in ascending order or twice to sort the results in descending order.

Note: To sort on multiple columns, you must group the results.

Optional. To remove all sorting, right-click a column heading and select Reset sort order.
Save the view orfilter to preserve the sort order.

Select columns to display

To show or hide columns in a view or public filter, complete the following steps.

1.
2.

3.

In View Designer, in the Preview pane, click the Columns button.
In the Columns dialog box, do the following substeps:

1. Forthe column or columns you want to hide, clear the check box. To hide all columns, right-click
anywhere in the dialog box and then click Clear All.

2. Forthe column or columns you want to show, select the check box. To show all columns, right-
click anywhere inside the dialog box and then click Select All.

3. Click OK.
In the Designer toolbar, click the Save button.

Group view or search results

You can group the results of a view, filter, or search by one or more columns into groups you can expand and
collapse. To group view results, complete the following steps.

1.

In the search results grid or view preview grid, right-click a column heading, and then click Group by
this Column.

Groups are initially collapsed when the view or filter runs.

Optional. To create a subgroup under the grouped column, right-click a column heading, and then click
Group by this Column.

Optional. To expand the grouped results, right-click a column headings, and then click Expand All
Groups.

Save the view or filter to preserve the column grouping.

52



About viewing batches by batch user

A user can view batches captured by batch users, and can be limited to viewing batches captured only by
specific batch users.

Users can capture batches with the Global > Capture > Batch Mode privilege and then view those batches.

If you want a user to view batches captured by any other batch users, you must give the user the Drawer >
Batch (Proposed Key) > Process privilege for each drawer.

If you want to limit a user to viewing batches captured only by specific batch users, you must also enable
filtering by batch user. When you enabile filtering by batch user, you create a list of only those batch users
whose batches you want the user to view.

Add a custom property column

To add columns to display custom property values for content, complete the following steps.

1. Access the view using one of the following methods:

Situation Steps
Add a custom property column for a workflow 1. Open the workflow process in Workflow
queue view Designer.
2. InWorkflow Designer, open the desired
queue.
3. Inthe Queue Properties dialog box, click
Appearance.

4. Inthe right pane, click Preview.

Add a custom property column for a view 1. Open the view in View Designer.
2. InView Designer, click View > Preview.

Add a custom property column for a folder 1. In Management Console, in the left pane,
content view click Folder Types.

2. Intheright pane, on the Folder Types tab,
select the folder type and click Modify.

3. Inthe Folder Type dialog box, on the
Appearance tab, click Preview.

2. Inthe View Preview window, click the Columns button.

3. Inthe Columns dialog box, click Add.

4. Inthe Custom Property dialog box, select the Filter by list and do one of the following actions:
« Todisplay a custom property based on item type, select Document Types.



« Todisplay a custom property based on folder type, select Folder Types.
« Todisplay all custom properties, select All Custom Properties.

5. Inthe Type list, select a custom property.
The Type list options change based on the Filter by option selected.

6. Select a custom property and click Add.

7. Click OK.

Enable filtering by batch user for a group

A group can view batches captured by batch users if granted the appropriate drawer privileges for the drawers
for which the batches are targeted. To further limit groups to viewing only batches captured by specific batch
users, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select Cross Department
Settings from the list.

In the left pane, click Groups.

In the right pane, select the group you want and click Modify.

In the Modify Group Profile dialog box, in the left pane, click Batch Users.
Select Enable filtering by batch user.

To add batch users to the list, complete the following substeps.

1. Click Add.

2. Inthe Select Users dialog box, under Available Users, select a user and click Add.
3. Click OK when you finish adding batch users.

7. Optional. To remove batch users from the list, complete the following substeps.
1. Click the batch user.

2. Click Remove.

ok wNbN

Enable filtering by batch user for a user

A user can view batches captured by batch users if granted the appropriate drawer privileges for the drawers
for which the batches are targeted. To further limit users to viewing only batches captured by specific batch
users, complete the following steps.

1. In Management Console, in the left pane, under Select Department, select Cross Department
Settings from the list.

In the left pane, click Users.

In the right pane, select the user you want and click Modify.

In the Modify User Profile dialog box, in the left pane, click Batch Users.

Select Enable filtering by batch user.

To add batch users to the list, complete the following substeps.

1. Click Add.

2. Inthe Select Users dialog box, under Search, select a user and click Add.
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3. Click OK when you finish adding batch users.

7. Optional. To remove batch users from the list, complete the following substeps.
1. Click the batch user.
2. Click Remove.

Add a custom property column for records

To add a custom property column for a record content view, complete the following steps.

1. In Management Console, in the left pane, click Records and select Record Folder Types or Record
Category Types.

2. Intheright pane, on the Record Folder Types or Record Category Types tab, select the folder type
and click Modify.

In the dialog box, on the Appearance tab, click Preview.
In the View Preview window, click the Columns button.
In the Columns dialog box, click Add.
In the Custom Property dialog box, select the Filter by list and do one of the following actions:
« Todisplay a custom property based on record type, select Record Types.
« Todisplay a custom property based on record folder type, select Record Folder Types.
« Todisplay all custom properties, select All Custom Properties.
7. Inthe Type list, select a record or record folder type.
The Type list options change based on the Filter by option selected.
8. Select a custom property and click Add.
9. Click OK.

o kv

Statistics

What are statistics?

Statistics are calculations such as the maximum, minimum, and average of all the values in a specific column
that appear in the search results for the view.

You can define statistics for any document view, folder view, task view, record view, or record folder view for
which you have management privileges. You cannot define statistics for a public filter or a related view.

For any folder type for which you have management privileges, you can create a view that determines the
appearance of the folder content results in Folder Viewer. You can also create a statistic for a workflow view,
which defines the appearance when viewing the contents of a workflow queue. When you define a set of
statistics for a folder content or workflow view, the statistics appear in a pane below the search results grid. In
the statistics pane, you can view the statistics, highlight the search results in the grid that apply to the
statistic, and, if only one document or folder matches the statistic value, open the document or folder.

The following examples demonstrate some ways you can use view statistics.
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Accounts Payable: Theresa is an Accounts Payable administrator who wants to quickly view the total
of all the invoices in her "Openlnvoices" view. This view contains a custom property column which
stores the invoice amount for each document. Because it is a numeric custom property, Theresa adds
a Sum statistic on this custom property column named "Total open amount". Every time she runs a
search using this view, she sees the total invoice amount of all the documents returned by the search
in the statistics pane.

Admissions: Sam is an Admissions director who wants to view the average ACT score of the students
who applied to his university in the current academic year. His student folder view contains a custom
property column which stores the ACT score for each student and a date range that spans the current
academic year. Because the view uses a numeric custom property, Sam adds an Average statistic on
this custom property column named "Average ACT."

Healthcare: Dr. Lovelace wants to quickly view the next task he is responsible for in his folder view
that lists all his patients with document deficiencies. His view administrator adds a Next statistic to
the task due date column in the view. When Dr. Lovelace logs in, he can quickly see the date the next
task is due, highlight the document associated with the task, and open it in ImageNowViewer.

To view records functionality, you must install a Records Manager license.

Data types for statistical functions

The statistical functions you can define depend on the data type of the column values. To add a statistic for a
custom property column, you must first add the custom property column to the view. The following statistics
are available for the specified data types.

Statistical functions

Average
This function calculates the average of the column values.

Column value data type

Numeric

Sample columns
Summary Task Count

<Number custom property>

Count

This function counts the number of values in the search results grid that match the selected variable
(you must select a variable for this statistical function).

Column value data type

String, list, flag
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Sample columns
Folder Name
In Workflow
<List custom property>
<String custom property>

<Flag custom property>

Count Future
This function counts the number of the column's date values that occur in the future.

Column value data type

Date

Sample columns
Next Task Due
Due Date

<Date custom property>

Count Past
This function counts the number of the column's date values that occur in the past.

Column value data type

Date

Sample columns
Created
Last Viewed

<Date custom property>

First

This function distinguishes the earliest date in the column's search results.
Column value data type

Date



Sample columns
Modified
Checked Out

<Date custom property>

Last

This function distinguishes the latest date in the column's search results.
Column value data type

Date

Sample columns
Checked In
Assigned

<Date custom property>

Maximum
This function distinguishes the largest numeric value in the column's search results.

Column value data type

Numeric

Sample columns
Pages

<Number custom property>

Median
The function distinguishes the middle value in the column's search results.

Column value data type

Sample columns
Current Version

<Number custom property>

Minimum
This function distinguishes the smallest numeric value in the column's search results.



Column value data type

Numeric

Sample columns
Days Until Due

<Number custom property>

Mode

This function distinguishes the most frequently occurring numeric value in the column's search
results.

Column value data type

Numeric

Sample columns
Summary Task Count

<Number custom property>

Next

This function distinguishes the next sequential date value in the column's search results.
Column value data type

Date

Sample columns
Status Changed

<Date custom property>

Previous
This function distinguishes the previous sequential date value in the column's search results.

Column value data type

Date

Sample columns
Completed

<Date custom property>

Sum
This function calculates the total of the values in the column's search resullts.



Column value data type

Numeric

Sample columns
Pages

<Number custom property>

Add view statistics overview

The configuration of a view statistic differs based on the data value type you select. You can create statistics
for document, folder, folder content, record, task, and workflow views. To create a statistic for a view,
complete any of the following procedures.

« Add a statistic for a date value.

» Add a statistic for a flag value.

« Add a statistic for a list value.

o Add a statistic for a numeric value.

» Add a statistic for a string value.

Add a statistic for a date value

You can display the newest, oldest, or next date value in a list of search results, or display the total number of
dates in the past or dates in the future. To add a statistic for a date value, complete the following steps.

Prerequisite Before you can add a statistic for a date custom property value, you must first add the custom
property column to the view.

2. Inthe Preview pane, click the Statistics button.
3. Inthe Statistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to view the next task due date, type Next task due.

5. Under Column, select the view column with the date values.
6. Under Function, select one of the following options depending on the display variable you want to

show:
Situation Steps
Total number of dates in the future « Select Count Future.

Total number of dates in the past « Select Count past.




10.

Situation Steps

Oldest date value « Select First.
Newest date value o Select Last.

The next future date « Select Next.

The most recent date « Select Previous.

Optional. Under Caption, select the value to display when the statistic only applies to one search
result.

Example If a Previous statistic shows the last viewed item, and you want to quickly display the user
name of the user who viewed the item, you can use the Caption column to select the Last Viewed By
user.

Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.

Click OK.

The statistic appears below the grid in the Preview pane.

In the Preview pane, click the Run button to test the statistic's performance.

Add a statistic for a flag value

You can add a statistic that distinguishes the number of search results that have a true or false (boolean)
value. To add a statistic for a flag value, complete the following steps.

Prerequisite Before you can add a statistic for a flag custom property value, you must add the flag custom
property column to the view.

In the Preview pane, click the Statistics button.

In the Statistics dialog box, click Add.

Under Label, type a label that describes the statistical function to appear in the search results grid.
Example If adding a statistic to count the number of documents or records assigned to a retention
policy, type Documents in RetentionoOrRecords in Retention.

Under Column, select the view column with the flag values.

Under Function, select Count.

Under Variable, select whether you want to count the results that meet the TRUE condition or the
FALSE condition.

Optional. Under Caption, select the value to display when the statistic applies to only one search
result.



Example If there is one version-controlled item in your search results, and you want to quickly display
the user who marked the item private, you can use the Caption column to select the Private By user.

9. Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.
10. Click OK.
The statistic appears below the grid in the Preview pane.
11. Inthe Preview pane, click the Run button to test the statistic's performance.

Add a statistic for a list value

You can add a Count statistic that distinguishes a unique value of alist custom property. To add a statistic for
a list value, complete the following steps.

Prerequisite Before you can add a statistic for a list value, you must first add the list custom property
column to the view.

2. Inthe Preview pane, click the Statistics button.

3. Inthe Statistics dialog box, click Add.

4. Under Label, type a label that describes the statistical function to appear in the search results grid.
Example If you have a list custom property to select the fiscal quarter associated with an invoice and
you want to add a statistic to show fourth quarter invoices, type Invoices in Q4.

5. Under Column, select the list custom property.

6. Under Function, select Count.

Note: Countis the only statistical function for list values.

7. Inthe Variable list, select an item from the list to use for the statistic.
8. Optional. Under Caption, select the value to display when the statistic applies to only one search
result.

Example If there is only one item added to workflow during the month of January, and you want to
quickly display the user who added the item to workflow, you can use the Caption column to select the
workflow user.

9. Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.
10. Click OK.
The statistic appears below the grid in the Preview pane.
11. Inthe Preview pane, click the Run button to test the statistic's performance.



Add a statistic for a numeric value

You can display the average, sum, median, or mode statistic that distinguishes numeric values, such as the
number of tasks or a custom property that stores an amount value. To add a statistic for a numeric value,
perform the following steps.

Prerequisite Before you can add a statistic for a flag custom property value, you must add the flag custom
property column to the view.

10.

In the Preview pane, click the Statistics button.

In the Statistics dialog box, click Add.

Under Label, type a label that describes the statistical function to appear in the search results grid.
Example If adding a statistic to view the average amount of invoices, type Average invoice
amount.

Under Column, select the view column with the flag values.

Under Function, select the display variable you want to show.

Optional. Under Caption, select the value to display when the statistic applies to only one search
result.

Example If a Maximum statistic displays the invoice with the highest amount, and you want to quickly
display the user name of the user who last viewed the invoice, you can use the Caption column to
select the Last Viewed By user.

Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.

Click OK.

The statistic appears below the grid in the Preview pane.

In the Preview pane, click the Run button to test the statistic's performance.

Add a statistic for a string value

You can add a non-case sensitive Count statistic that distinguishes string values, such as a task template or
drawer name. To add a statistic for a string value, which you can add at the view or filter level, perform the
following steps.

Prerequisite Before you can add a statistic for a flag custom property value, you must add the flag custom
property column to the view.

In the Preview pane, click the Statistics button.
In the Statistics dialog box, click Add.
Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to count the number of items scanned by the department manager, type
Scanned by Manager.

Under Column, select the view column with the string values.



Under Function, select Count.

Note: Count is the only statistical function for string values.

7. Under Variable, type the value for the statistic, such as the drawer name or task template name.
8. Optional. Under Caption, select the value to display when the statistic applies to only one search
result.
Example If there is only one items for a specific vendor in your workflow process, and you want to
quickly determine if it is an invoice or a purchase order, you can use the Caption column to show the
Document Type.
9. Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.
10. Click OK. The statistic appears below the grid in the Preview pane.
11. Inthe Preview pane, click the Run button to test the statistic's performance.
Modify a statistic

To modify the components of a statistic defined for a view, complete the following steps.

4.
5.

In the Preview pane, click the Statistics button and then, in the Statistics dialog box, click the row of
the statistic you want to change.

Do one of the following actions.

« Tochange the statistic definition, highlight the statistic row and then modify the components you
want to change.

« Toreposition the statistic, click Move Up to move it ahead of the preceding statistic, or click Move
Down to move it after the following statistic.

Click OK.
In the Preview pane, click the Run button to test the statistic's performance.

Remove a statistic

To remove a statistic from a view, complete the following steps.

2.
3.
4.

In the Preview pane, click the Statistics button.
In the Statistics dialog box, click the row of the statistic you want to remove and click Remove.
Click Yes in the confirmation prompt and then, in the Statistics dialog box, click OK.

Result Removing a statistic does not remove the column from the view.
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